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Preface

The Sun Management Center 3.0 Performance Reporting Manager User’s Guide provides
instructions on how to use Performance Reporting Manager to create system
management reports.

Who Should Use This Book
This document is intended for users familiar with the Sun Management Center
product. Therefore, many terms and concepts specific to the Sun Management Center
are not explained here. For more information about Sun Management Center, refer to
the Sun Management Center 3.0 User’s Guide.

How This Book Is Organized
This document describes all services offered by Performance Reporting Manager. It
includes the following chapters:

� Chapter 1 provides an introduction to Performance Reporting Manager.
� Chapter 2 includes installation and setup instructions.
� Chapter 3 includes instructions for using standard reports.
� Chapter 4 includes instructions for using custom reports.
� Chapter 5 includes instructions for using report options.
� Appendix A provides reference information for Performance Reporting Manager.
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Access to Latest Information on Sun
Management Center
For the latest information on the Sun Management Center 3.0 software and the
Performance Reporting Manager add-on product, refer to: http://www.sun.
com/solaris/sunmanagementcenter

Using UNIX Commands
This document might not contain information on basic UNIX® commands and
procedures such as shutting down the system, booting the system, and configuring
devices.

See one or more of the following documents for this information:

� Solaris Handbook for Sun Peripherals
� Online documentation for the Solaris™ operating environment
� Other software documentation that you received with your system

Typographic Conventions

Typeface Meaning Examples

AaBbCc123 The names of commands, files, and
directories; on-screen computer
output

Edit your.login file.

Use ls -a to list all files.

% You have mail.

AaBbCc123 What you type, when contrasted
with on-screen computer output

% su

Password:
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Typeface Meaning Examples

AaBbCc123 Book titles, new words or terms,
words to be emphasized. Replace
command-line variables with real
names or values.

Read Chapter 6 in the User’s Guide.

These are called class options.

You must be superuser to do this.

To delete a file, type rm filename.

Shell Prompts

Shell Prompt

C shell machine-name%

C shell superuser machine-name#

Bourne shell and Korn shell $

Bourne shell and Korn shell superuser #

Accessing Sun Documentation Online
The docs.sun.comSM Web site enables you to access Sun technical documentation
online. You can browse the docs.sun.com archive or search for a specific book title or
subject. The URL is http://www.docs.sun.com.

Sun Welcomes Your Comments
Sun is interested in improving its documentation and welcomes your comments and
suggestions. You can email your comments to Sun at docfeedback@sun.com.

Please include the part number (816-2761) of this document in the subject line of your
email.
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CHAPTER 1

Introduction to Performance Reporting
Manager

This chapter discusses the following topics:

� “About Performance Reporting Manager” on page 11
� “Data Collection” on page 12
� “Report Manager” on page 14
� “Report Requests” on page 15
� “Categories and Subcategories” on page 15
� “Report Output Format Options” on page 16

About Performance Reporting Manager
Performance Reporting Manager is an add-on to Sun Management Center 3.0 that
enables you to create reports detailing the status of your machines. Performance data
is gathered by the history logging capability that is part of Sun Management Center
3.0. Performance reports generated with Performance Reporting Manager use the data
collected in this manner.

The product includes 12 standard reports for which the report options are predefined.
History logging of the data properties used in standard reports is automatically
started by the software. You can also create your own custom reports by selecting
options from the report templates that are provided. Performance Reporting Manager
can generate the following types of reports:

� Performance
� Hardware system
� Hardware configuration
� Packages
� Patches
� Alarms
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Reports can either provide information about one host, or all hosts, or a set of hosts
that you designate. In general, data is collected on the agent machines and is then
transferred to a database on the server machine. You can request a report for any agent
machine for which data has been collected. A host must be in the Sun Management
Center 3.0 server context to be included in a report. For more information about how
the data in reports is collected, see “Data Collection” on page 12.

The host name in a report usually refers to the agent machine. One exception is in the
case of alarm reports. Alarms resulting from an agent machine that is down or is
otherwise not responding will list the name of the server machine.

To use Performance Reporting Manager, the first step is to install and set up the
add-on software. For information about the installation and setup of Performance
Reporting Manager, see Chapter 2.

After the Performance Reporting Manager add-on is installed and set up, you can
generate any of the standard reports that are included with the software. For more
information about standard reports, see Chapter 3.

You can also create your own custom reports. You select the format for your report
from the available report formats given. Performance Reporting Manager includes
four possible format options for viewing reports. For information about creating
custom report requests, see Chapter 4.

Any standard or custom report can be scheduled to generate automatically at a regular
interval. Additionally, you can save reports in other file formats for either viewing in a
web browser, or for using tools to analyze data. For more information regarding these
report options, see Chapter 5.

Performance Reporting Manager automatically logs a number of data properties.
These are predefined for you. For more information regarding this feature, and for
other reference information, see Appendix A.

Data Collection
Before installing and using the software to generate reports, you should have an
understanding of how data collection occurs. The Performance Reporting Manager
add-on uses the history logging capability for agent machines that is provided by the
Sun Management Center 3.0 software. A data collection service is created on the server
layer. The following types of data are collected:

� Hardware system data
� Hardware configuration data
� Software package data
� Software patch data
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� Performance (history.log) data
� Process data

The data is logged on the agent machines. The data collection service on the server
layer collects this data from the agent machines and then stores it. The data returned
in reports comes from the data stored on the server or stored on the agent machine.

Raw Data
Raw data is the term given to data that is logged in the history log files located on the
agent machines. The ability to log raw data is a feature contained of Sun Management
Center 3.0 base product. This data can be logged either on a single machine, or on a
group of machines by using the grouping capability. If you use the grouping
capability, the data is logged at the time interval you specify in the Property Logging
dialog box for the data property. The grouping capability is a feature of the Premier
Management Applications add-on to Sun Management Center 3.0. For more
information about the grouping capability, see “Data Properties” on page 47 and Sun
Management Center 3.0 User’s Guide.

Raw data is retained on the agent machine for eight days. This limit is necessary
because the total volume of raw data is very large. Data will start purging after eight
days. For example, on the ninth day, the first day of raw data is purged from the agent
machine. At any given time on the agent machine, the last eight days of raw data is
available. Before this data is purged, summary records are preserved. For more
information regarding this process, see “Roll-up Process” on page 13.

Roll-up Process
Before the raw data is purged, the data is summarized, or “rolled-up”, at predefined
intervals. Roll-up data is the term given to the data that has been summarized. Before
any raw data is purged, the minimum, maximum, and average values are calculated
and can be preserved in several ways.

Hourly data is the term given to data that is summarized, or rolled-up, every hour. The
raw data for each hour is processed to create a summary record for that hour. For
example, if raw data is logged every five minutes, a total of twelve raw records are
available in one hour. When this data is rolled-up after one hour, the twelve raw
records are processed in order to find the minimum, maximum, and average values
during that hour. One summary record is generated for the twelve raw records. The
hourly data is first computed on the agent machine, and is then brought over to the
server machine where it is added to the database.

This method is the way raw data is rolled-up into hourly data at the end of each hour.

The daily, weekly, and monthly values are calculated in a similar manner. The
maximum, minimum, and average values are also calculated for each period.
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Report Data
Polling starts after the Performance Reporting Manager software is installed and set
up, and once the server is started. The Sun Management Center 3.0 server starts
polling the agent machines every hour to collect the data logged on those machines.
Logged data is available for reports at the following intervals:

� Hardware system data: 90 minutes after the server is started
� Patch and package data: 30 minutes after the server is started
� Hardware configuration data: 90 minutes after the server is started
� Performance data: 90 minutes after the server is started

Data on the agent machines is collected at different times. Data is logged on an agent
machine after the following time intervals:

� Hardware system and hardware configuration data: Every 12 hours

� Patch and package data: Every 12 hours

� Performance data: According to the logging interval specified in the Property
Logging Setting dialog box. This data is stored in the circular history.log file.

� Process data: Every 15 minutes

The data collection service on the server layer collects the data in the following
manner:

� Agent machines: Data is collected from those machines that are in the current
server context and have the Performance Reporting Manager software installed.

� Performance data: Roll-up data is collected every hour.

Report Manager
The Report Manager GUI is linked to the Sun Management Center 3.0 Java™ console
only, and is opened from the Tools menu. You manage all report activity through the
Report Manager GUI. For example, from Report Manager you can generate a report,
or create a new custom report, or schedule a report to generate at regular intervals.

For more information, see “Report Manager GUI” on page 32.
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Report Requests
You can either use any of the standard reports included with Performance Reporting
Manager, or create your own custom system management reports. For all standard
reports, the report specifications and report format are already predefined and saved
for your repeated use.

A custom report enables you to specify the content you want included in your reports,
as well as the report output format. The saved report specifications are called a report
request. The report request is based on one of several report templates. A report request
is used to generate either a standard or a custom report. The report request is also
used to schedule reports to run regularly.

For more information about using standard report requests, see Chapter 3. For more
information about creating custom report requests, see Chapter 4.

Categories and Subcategories
The reports in the Report Manager GUI are organized by category and subcategory
name. The left pane of Report Manager displays the hierarchy view that shows all the
reports by name, both for standard and custom reports.

The first level of the hierarchy contains the category names. The second level of the
hierarchy contains the subcategory names. The report requests themselves are found
at the third level of the hierarchy. All standard reports are organized in the hierarchy
view under predefined categories and subcategories.

You can place any type of custom report under the category or subcategory of your
choosing. This ability enables you to control the organization of your reports.

Performance Reporting Manager has the following predefined categories and
subcategories:

� Alarm

� Alarms
� Hardware

� System
� Configuration

� Performance

� CPU
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� Swap
� Memory

� Software

� Packages
� Patches

Report Output Format Options
Performance Reporting Manager provides four possible output formats for its reports:

� Tabular
� Line graph
� Bar chart
� Pie chart

All four format options are not available for every report. The type of report
determines the format options available. Certain formats do not make sense for
particular reports, so they are not always given as an option. When creating a custom
report request, you choose from the available format options given at that time.

Once a report request is saved, an icon depicting the report format option that is
selected appears in the hierarchy view in the Report Manager GUI. Each icon is
representative of the format chosen for the report. A lock symbol is added to the icon
when the request is for a standard report that comes with Performance Reporting
Manager. Standard reports have predefined reporting options that you cannot change.

Tabular
The tabular report option returns data in table format. The distinctive icon for the
tabular option is a table. The table icon is a grid with rows and columns. The cells of
the table contain the numerical values for the data properties specified in the report
request. You change the column sizing by dragging either edge of the column heading.
If the title to a column heading appears truncated, or is followed by several dots, you
can resize the column in order to view all information. Tabular reports can be sorted
by clicking on a column, except for performance reports. Performance reports are
presorted according to the time field.

When the Real Time range is selected for a tabular report, the information is updated
by clicking the Refresh button located on the right top of the table. The new data is
added to the top of the table.
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Line Graph
The line graph report option returns data as graphs with line plots. The line graph
icon is a graph with a climbing, jagged line. The number of graphs contained in each
report depends on the Graph Orientation option selected in the report request.

When the Real Time range is selected for a report, the graph refreshes according to the
refresh interval of the properties being logged. For Real Time reports only the last
hour of data is visible on the graph at any point in time.

Each line graph report has several viewing options. For example, you can use the
Zoom button to highlight a particular point on a data line. Zoom enables you to view
finer, more granular data for any point on a line. The Alarms button enables you to
obtain the alarm detail for any host included in the report. The Processes button
similarly enables you to obtain the top ten CPU processes and the top ten memory
processes for any host in the report. For more information, see “Line Graph Report
Viewing Options” on page 60.

The following figure shows a sample line graph report. The results returned after
running a standard performance report are shown. The report title is at the top, which
in this example is CPU Utilization For Last 24 Hours. The host name included in this
report is below the report title. The eight lines contained in the report are plotted in a
graph with both an X-axis and Y-axis defined. Each line is marked with symbols that
represent data points. The legend at the bottom of the graph identifies the
characteristics of each line. The legend further identifies what each line represents. The
Zoom radio button is activated. Once a point on the graph is selected, detail about that
point will be displayed.
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FIGURE 1–1 Sample Line Graph from a Standard Performance Report

Bar Chart
The bar chart report option returns data as one or more graphs with bar lines. The bar
chart icon is a graph that contains three horizontal bar lines. The number of graphs
contained in each bar chart report is controlled by the Graph Orientation option
selected in the report request. This format enables you to create a report that provides
a visual comparison of data values.

Each bar chart graph has the same viewing options as discussed for the line graph
report option.
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Pie Chart
The number of pie chart reports returned depends upon whether or not the data
property hostname is included in the report request. The report returns data as one
pie chart per host, if hostname is specified in the report request. If the data property
hostname is not specified in the report request, only one pie chart is generated in the
report. Pie chart reports are not available for performance and hardware configuration
reports when the Level of Detail:Summary option is selected. The pie chart icon is a
circle with a single line that depicts the radius.

For more information about the selection of data properties in a report request, see
“Data Properties” on page 41.
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CHAPTER 2

Performance Reporting Manager
Installation and Setup

This chapter discusses the following topics:

� “Performance Reporting Manager Software” on page 21
� “Installing Performance Reporting Manager” on page 23
� “Setting Up Performance Reporting Manager” on page 25
� “Before Generating Reports” on page 26
� “Backup and Restore” on page 27
� “Removing Performance Reporting Manager” on page 28

Performance Reporting Manager
Software
Performance Reporting Manager is installed as an add-on to the Sun Management
Center 3.0 software. The software runs on the Solaris™ 2.5.1, Solaris 2.6, Solaris 7,
Solaris 8, and Solaris 9 operating environment, all the platforms that the Sun
Management Center 3.0 agent can run on, and that are supported by Sun Management
Center 3.0.

The Performance Reporting Manager server layer requires that you have 1 Gbyte
RAM and 1 Gbyte swap space available on the machine.

The following disk space requirements are needed before installing the Performance
Reporting Manager software and running the setup script.

� Server: The disk space requirement for the server layer can vary based on the size
of the configuration you choose during setup.

� Small configuration: The disk space requirement is 4 Gbytes. This configuration
supports up to 100 agent machines that are monitoring 500 properties each.
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� Medium configuration: The disk space requirement is 12 Gbytes. This
configuration supports up to 400 agent machines that are monitoring 600
properties each.

� Large configuration: The disk space requirement is 22 Gbytes. This
configuration supports up to 750 agents that are monitoring 650 properties
each.

� Agent: The disk space requirement for the agent layer can vary based on the
number of properties being logged and their log interval. For 1000 properties
logged at five-minute intervals, the disk space requirement is approximately 80
MBytes.

� Console: 3 MBytes is the disk space requirement.

Before installing Performance Reporting Manager, you must have the following
already installed and set up:

� Sun Management Center 3.0 software
� Premier Management Applications add-on software
� Config-Reader add-on software specific to your platform
� The minimum recommended Sun Management Center 3.0 patch level

For any late-breaking information, please see the README file for Performance
Reporting Manager.

You can obtain the latest Sun Management Center 3.0 patches either at
http://www.sun.com/solaris/sunmanagementcenter/support_services.
html, or http://sunsolve.sun.com/pub-cgi/show.pl?
target=patches/patch-access.

If necessary, download the patch ID specific to your operating environment and Sun
Management Center 3.0 release version, as listed in the following table.

TABLE 2–1 Minimum Recommended Patch Level

Operating Environment Sun Management Center 3.0 RR
Version (Build 39)

Sun Management Center 3.0 GA
Version (Build 41)

Solaris 2.5.1 110861-05 110862-05

Solaris 2.6 110971-06 110936-06

Solaris 7 110972-06 110937-06

Solaris 8 110973-06 110938-06

Solaris 9 110973-06 110938-06

Microsoft Windows 110863-05 110863-05

If you are not sure which version of Sun Management Center 3.0 you have installed on
your system, type the following command to verify your particular build number:

# pkgparam SUNWescom VERSION
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The Performance Reporting Manager add-on consists of the following packages:

� SUNWescrg: Performance Reporting Manager add-on package for Sun
Management Center console layer

� SUNWessrg: Performance Reporting Manager add-on package for Sun
Management Center server layer

� SUNWesarg: Performance Reporting Manager add-on package for Sun
Management Center agent layer

� SUNWesdrg: Performance Reporting Manager add-on package for Sun
Management Center database layer

� SUNWeslrg: Performance Reporting Manager add-on package for Sun
Management Center server and console layer

� SUNWeshrg: Performance Reporting Manager online help package

Installing Performance Reporting
Manager
Installation of Performance Reporting Manager follows the standard Sun Management
Center 3.0 add-on installation procedures. For more information about add-on
installation, refer to the Sun Management Center 3.0 Installation Guide.

Performance Reporting Manager must be installed on the following layers of Sun
Management Center 3.0:

� Console layer
� Server layer
� Agent layer, on all hosts for which you want to generate reports

The interactive es-inst installation script installs the correct Performance Reporting
Manager packages on the console, server, and agent layers. For the agent package, the
module configuration files and libraries are installed in standard Sun Management
Center 3.0 locations.

� To Install Performance Reporting Manager

Note – You must stop all Sun Management Center 3.0 agent and server components
before beginning the installation procedure.

Chapter 2 • Performance Reporting Manager Installation and Setup 23



1. Confirm you have the minimum recommended Sun Management Center 3.0 patch
level installed.

See Table 2–1 for a list of patches.

2. Confirm you have the Premier Management Applications add-on for Sun
Management Center 3.0 installed.

For more information about this add-on software, see Sun Management Center 3.0
Installation Guide.

3. As superuser, run the installation script by typing:

# /opt/SUNWsymon/sbin/es-inst

/opt is usually the directory where Sun Management Center 3.0 is installed.
Substitute the name of the actual directory if it is different on your system.

4. Provide the source directory of the Performance Reporting Manager files when
prompted.

The source directory is usually: /Performance Reporting Manager
directory/disk1/image

5. To install the Performance Reporting Manager, answer “Yes” when prompted.

The es-inst script installs Performance Reporting Manager.

The es-inst script then automatically proceeds to setup prompt.

6. At the setup prompt, answer n for “No”. When you are ready to do the set up, see
“To Set Up Performance Reporting Manager Post-Install” on page 25.

Caution – You must answer “No” at the setup prompt at this point, before proceeding
to the next procedure.

� To Install on the Microsoft Windows Platform
1. Download the PRMWin.tar file from disk1 of the software image, or place the CD

containing this file in the CD-ROM drive.

2. Extract all the files and place them in a directory.

3. Set the CLASSPATH environmental variable to the directory where you placed the
extracted files.

4. Set the path by typing:

# PATH=C:\Progra~1\SunMC3.0\javasoft\bin

5. Change to the directory where you placed the extracted files.

24 Sun Management Center 3.0 Performance Reporting Manager User’s Guide • May 2002



6. Start the installation script by typing:

# java PRMWinInst

The installation GUI appears.

7. Click on Install.

Setting Up Performance Reporting
Manager
After installation is complete, you must run the Performance Reporting Manager
setup script to configure the server and agent layers. You must already have set up
the Sun Management Center 3.0 core server layer before running the setup script for
Performance Reporting Manager.

� To Set Up Performance Reporting Manager
Post-Install

Note – You must stop all Sun Management Center 3.0 agent and server components
before beginning the setup procedure.

� Run the setup script as superuser by typing:

# /opt/SUNWsymon/sbin/es-setup -p PRM

/opt is usually the directory where Sun Management Center 3.0 is installed. Substitute
the name of the actual directory if it is different on your system.

During the server setup, you are given three different configuration choices based on
the number of agent machines and data properties you will monitor. You are
prompted three times for data file locations. While you can enter the same directory
three times, try to use three different directories located on three different filesystems.
This separation will reduce disk I/O contention and results in better product
performance. Depending upon the size of the configuration you choose during setup,
the data file locations you specify will require space as listed in the following table.

Chapter 2 • Performance Reporting Manager Installation and Setup 25



TABLE 2–2 Data Directory Sizes For Server Layer

Configuration Size First Directory Size Second Directory Size Third Directory Size

Small 2048 MB 1536 MB 512 MB

Medium 5120 MB 4096 MB 3072 MB

Large 8192 MB 7168 MB 7168 MB

At the end, the es-setup script asks you if you want to start a backup of Sun
Management Center 3.0. If you answer y for “Yes”, the Sun Management Center 3.0
server processes will start automatically at the end of set up. You do not need to start
the server at this time. See “Backup and Restore” on page 27 for more information.

If you need to run the Performance Reporting Manager setup script again at any
time, use this procedure to start the script.

Note – Once you have completed installing and setting up Performance Reporting
Manager and you answer “No” to preserve the data, you must run the Performance
Reporting Manager setup script again using es-setup -p PRM.

Before Generating Reports
Once you have completed the installation and setup, you must start the Sun
Management Center 3.0 server. For more information about starting the server, see Sun
Management Center 3.0 Installation Guide.

Until data is being logged and collected, you cannot generate reports. For more
information about how data is collected, see “Data Collection” on page 12.

Report scheduling and server side generation of reports requires the use of an X
server. Before starting the Sun Management Center 3.0 server, you must first verify
that your environment is set correctly. Do this after you have run the Performance
Reporting Manager setup script, but before you start the server. Once done, leave the
Terminal window connected to the server at all times.

� To Set the Environment
1. Check to see if an X server session is running on the Sun Management Center 3.0

server machine by typing in a Terminal window:

% ps -ef | grep Xsession
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2. If a session is already running, type the following:

% /usr/openwin/bin/xhost +

3. Start the Sun Management Center 3.0 server.

4. If a X server session is not already running, from a machine that has a terminal
attached, type:

% /usr/openwin/bin/xhost +

5. Remotely log into the server machine by typing:

% rlogin server-machine-name

6. On the server machine, set your environment by typing:

% setenv DISPLAY machine-name-with-terminal:0.0

Leave this window open at all times.

7. Start the Sun Management Center 3.0 server.

Backup and Restore
The Sun Management Center 3.0 backup and restore scripts can be used to backup or
restore all Sun Management Center 3.0 data, including Performance Reporting
Manager. For information, see “Database Backup and Recovery” in Sun Management
Center 3.0 Installation Guide.

The last step of the Performance Reporting Manager setup procedure ask you if you
want to start a backup of the Sun Management Center 3.0 data, including Performance
Reporting Manager. It is suggested that you answer “Yes” to the backup question. The
first backup of Performance Reporting Manager completed after set up replaces any
previous backup performed before running the es-setup script.

Performing frequent backups of your entire system will ensure the ability to recover
the most current data possible, in the event of a system failure. Frequent backups will
help to minimize any data loss.

Note – If you attempt to restore from a backup that was performed before the
Performance Reporting Manager add-on is setup, you will lose your Performance
Reporting Manager data.
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Caution – Do not attempt to restore a backup from a medium or large configuration if
the machine has been converted to a small configuration. Problems might result from
having insufficient disk space to restore the data, and you might experience
performance degradation. This type of restoration is not supported.

Removing Performance Reporting
Manager
You cannot remove an add-on through Sun Management Center 3.0. A removal script
is provided for Performance Reporting Manager. This script removes both the
Performance Reporting Manager packages and all the Performance Reporting
Manager data and configuration changes that were made during setup. A separate
removal script is included if you have installed only the console layer on a machine.
This script removes the console packages from the machine.

A removal script for the software from a PC is not provided. Uninstallation of the
Performance Reporting Manager software from a PC is not currently supported.

� To Remove the Performance Reporting Manager
Add-on

1. Become superuser.

2. Uninstall the layers you installed.

� If you have installed only the console layer, remove the console packages from the
machine by typing:

# /opt/SUNWsymon/addons/PRM/sbin/console-uninst.sh

/opt is usually the directory where Sun Management Center 3.0 is installed.
Substitute the name of the actual directory if it is different on your system.

� If you have installed any combination of console, server, and agent layers on the
machine, remove the add-on packages, the data, and the configuration files by
typing:

# /opt/SUNWsymon/addons/PRM/sbin/es-uninst.sh

/opt is usually the directory where Sun Management Center 3.0 is installed.
Substitute the name of the actual directory if it is different on your system.
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CHAPTER 3

Standard Reports

This chapter discusses the following topics:

� “Standard Reports Overview” on page 29
� “Report Manager GUI” on page 32
� “Generating Reports” on page 34

Standard Reports Overview
Performance Reporting Manager includes 12 standard reports with predefined options
that you cannot edit. A standard report has predefined report options that generate a
report that is generally useful to anyone monitoring a system. The report output
format is also predefined and cannot be changed.

Standard reports are organized by category and subcategory in the left pane of the
Report Manager GUI. Standard report requests are identified by the lock symbol that
appears on the report request icon. The lock reminds you that you cannot change the
predefined report options.

All standard reports generated by Performance Reporting Manager are classified as
being either a performance report or a system configuration report. A performance report is
designed to track properties that are numerical and change over time. An example of a
performance report is a graph that shows the percentage of CPU kernel usage on a
host over the last 24 hours. For more information about standard performance reports,
see “Standard Performance Reports” on page 30.

A standard system configuration report is designed to provide data detailing the state
of the configuration on that machine. An example of a system configuration report is a
table that summarizes all the patches currently installed on a particular machine or
machines. For more information about standard system configuration reports, see
“Standard System Configuration Reports” on page 31.
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Once generated, the output from all standard reports can be viewed in the Sun
Management Center 3.0 console, or in a web browser as an HTML file, or in a
comma-separated value (CSV) ASCII text file. The text file can be used with other tools
to analyze the data. See “Options for Viewing Report Output” on page 57 for more
information.

You must have the Kernel Reader Simple module loaded before you can run any
standard report. For a detailed list of properties that each standard report
incorporates, see “Standard Performance Reports” on page 30, “Standard System
Configuration Reports” on page 31, or Appendix A.

Standard Performance Reports
Performance data logging on agent machines is provided by the history logging
capability included with Sun Management Center 3.0. Performance Reporting
Manager only collects the data logged in the circular history.log file. The data then
is transferred to the Sun Management Center 3.0 server machine and loaded into the
database. Report data is obtained by making queries to the database to determine
trends in the performance statistics over a specified time period.

The report options are predefined in the report request. The report output format for
all standard performance reports is a graph. The following three standard
performance reports are included with Performance Reporting Manager. They are
organized by their category and subcategory names:

� Performance

� CPU

� CPU Utilization: This report lists the CPU utilization for the last 24 hours
using the Maximum function. The report data includes the % CPU kernel
time, and % CPU kernel user. The host name and port are entered when the
report is run.

� Swap

� Swap Available: This report lists the swap space available on each host over
time. The report data includes the available memory in Kbytes (anon
memory not provided). The host name and port are entered when the report
is run.

� Memory

� Memory Free: This report lists the amount of physical memory free in
megabytes on each host over time. The report data includes the amount of
physical memory free in Mbytes. The host name and port are entered when
the report is run.
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Standard System Configuration Reports
System configuration data is logged on the agent machines by the Performance
Reporting Manager logging component. This logging component is added to the agent
machine during installation. The data is then transferred to the Sun Management
Center 3.0 server machine and loaded into the database. Report data is obtained by
making queries to the database located on the Sun Management Center 3.0 server
machine. This method is similar to the way the data for standard performance reports
is obtained.

The report options are predefined in the report request. The report output format for
all standard system configuration reports is a table. The following nine standard
system configuration reports are included with Performance Reporting Manager. They
are organized by their category and subcategory names:

� Alarm

� Alarms

� Alarm Details: This report lists the all open alarms for each host. The report
data includes host name, operating system, alarm severity, alarm status,
open date, and alarm message. The host name and port is entered when the
report is run.

� Alarm Summary: This report lists the alarm status and alarm count for each
host. The report data includes the host name and alarm status. The report
provides detail for all hosts in the server context.

� Alarm Severity Count By Host: This report lists the alarm severity count for
each host. The report data includes the host name, alarm severity, and alarm
status. The report provides detail for all hosts in the server context.

� Hardware

� System

� System Details: This report lists the system details, for each host name, of all
hosts in the server context that have both the Config-Reader add-on and
Performance Reporting Manager installed. The report data includes the host
name, operating system, system clock frequency, platform type, total disks,
total memory, total processors, and total tape devices.

� Platform Summary: This report lists the platform type, for each host, for all
hosts in the server context that have the Config-Reader add-on and
Performance Reporting Manager installed. The report data includes
platform.

� OS Summary: This report lists the operating system, for each host, for all
hosts in the server context that have the Config-Reader add-on and
Performance Reporting Manager installed. The report data includes the
operating system.

� Configuration

� Software
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� Packages

� Hosts with SUNWcsr package: This report lists, for each host, those that
have the SUNWcsr package installed. The report data includes the host
name, package instance, package name, category, version, package
description, and install date. The report provides detail for all hosts in the
server context.

� Package Details: This report lists, for each host, all the software packages
installed on that host. The report data includes the host name, package
instance, package name, category, version, package description, and install
date. The host name and port is entered when the report is run.

� Patches

� Patch Details: This report lists, for each host, all the software patches
installed on that host. The report data includes host name, operating system,
patch id, packages, obsoletes, requires, and incompatibles. The host name
and port is entered when the report is run.

You can resize the columns in any tabular report by dragging the sides of the column
header. Additionally, you can sort any tabular report by double-clicking the column
headers. The report then sorts according to the header selected.

Report Manager GUI
You manage all report activity through the Report Manager GUI. For example, from
Report Manager you can generate a report from a report request, or create a new
custom report request, or schedule a report to generate at regular intervals. The Report
Manager GUI is linked to the Sun Management Center 3.0 Java™ console only. The
GUI is opened from the Tools menu.

Report Manager displays information in two panes. The left pane contains the
hierarchy view of the report requests. The report requests are organized by category
and subcategory. For more information about categories and subcategories, see
“Categories and Subcategories” on page 15.

The right pane in Report Manager contains three summary fields. These summaries
help you to quickly identify the important distinguishing characteristics of each report
request. After selecting a request name from the hierarchy view in the left pane, the
following information is displayed in the right pane:

� Report Request: The name and description of the report request
� Data Properties: The list of data properties selected for the report request
� Hosts: The host names included in the report
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� To Start Report Manager
1. Start the Sun Management Center 3.0 console.

2. Choose Report Manager from the Tools menu.

The Report Manager GUI appears. The hierarchy view is in the left pane, and the
report request summary is in the right pane.

3. Click the key symbol next to a category name to expand the hierarchy view.

The hierarchy view expands one level to display the subcategory name. The report
requests are identified by the report request name, and are located under the
subcategory name.

The following figure shows a sample of what the Report Manager GUI contains when
a standard performance report is selected from the hierarchy view. The left pane
shows that the CPU Utilization report request is selected in the hierarchy view. The
right pane displays a summary of some of the report options for the CPU Utilization
report request. The detail fields include Report Request, Data Properties, and Hosts.
The detail for each field provides a summary of the options that are predefined in the
report request.
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FIGURE 3–1 Sample of Report Manager With Details Showing for a Standard Report

Generating Reports
You can generate a standard report in one of three ways:

� By choosing Generate from the File menu in Report Manager.
� By double-clicking the name of the report request from the left pane in Report

Manager.
� By clicking the Generate icon in the menu. This is the first icon located under the

menu options.

Each time you generate a standard performance report, you must provide the host
name and corresponding port if this information is not predefined. The host name, if
entered when you generate the report, is not saved to the report request. You can
specify a different host name each time you generate a standard performance report.
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For standard system configuration reports, a report is generated for all hosts identified
in the Sun Management Center 3.0 server context that also have the Performance
Reporting Manager software installed.

For more information about standard performance and system configuration report
requests, see “Standard Reports Overview” on page 29.

Any report, whether it is a standard or a custom report, is generated this way. For
information about scheduling reports to run at regular intervals, see “Scheduling
Reports” on page 56.

� To Generate a Standard Report

Note – You must have the Kernel Reader Simple module loaded in order to run any
standard report.

1. Start Report Manager.

2. Select the name of the desired report request from the hierarchy view.

Verify that this report request is correct by reviewing the summary information
contained in the right pane.

3. Choose Generate from the File menu.

The standard report is generated. A second window opens that contains the report
output.

4. If a dialog box appears, type the host name and corresponding port.
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CHAPTER 4

Custom Reports

This chapter discusses the following topics:

� “Custom Reports Overview” on page 37
� “Adding a New Category or Subcategory” on page 38
� “Custom Report Templates” on page 39
� “Data Properties” on page 47
� “Filtering Reports” on page 52
� “Customizing the Appearance of Reports” on page 53
� “Composite Report Requests” on page 53

Custom Reports Overview
Performance Reporting Manager enables you to create your own custom reports. You
use one of the report templates provided to create custom reports. The correct
template is displayed automatically for you, depending upon the report request type
selected from the menu. The report templates contain similar options, but there are
differences between them. For more information about the fields contained in the
report templates, see “Custom Report Templates” on page 39.

Unlike a standard report in which the report output format is predefined, you can
specify the output format when creating a custom report. The possible output options
are a table, a line graph, a bar chart, or a pie chart. At the time you complete the report
template, you are offered only the valid output options for the type of report request
you are creating. For more information about report format options, see “Report
Output Format Options” on page 16.

Before creating a custom report, you should be familiar with how Performance
Reporting Manager collects the data that is polled for reports. For more information,
see “Data Collection” on page 12.
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Adding a New Category or Subcategory
You can add a new category and subcategory to the report hierarchy. You can then
place your custom reports under a category and subcategory you create. Or, you can
choose to place the reports under one of the predefined categories. For more
information about the predefined options, see “Categories and Subcategories”
on page 15.

New categories are added to the bottom of the list in the hierarchy view. Each new
subcategory is added to the bottom of its corresponding category.

� To Create a New Category
1. Start Report Manager

For the detailed steps, see “To Start Report Manager” on page 33.

2. From the File menu, choose New, then select Category.

The Create Category dialog box appears. It contains two text fields.

3. Type the new category name in the Name field.

4. (Optional) Type the description of the category in the Description field.

5. Click OK to finish adding the category to the hierarchy view.

When the category name is selected, the name and description appear in the Report
Category summary in the right pane.

� To Create a New Subcategory
1. Start Report Manager.

For the detailed steps, see “To Start Report Manager” on page 33.

2. From the File menu, choose New, then select Subcategory.

The Create Subcategory dialog box appears. It contains two text fields.

3. Select the desired Category from the drop-down menu.

4. Type the new subcategory name in the Name field.

5. (Optional) Add a description of the subcategory in the Description field.

The new subcategory name will appear at the second level in the hierarchy view,
beneath the category name.
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6. Click OK to finishing adding the subcategory.

When the subcategory name is selected, the name and description appear in the
Report Subcategory summary in the right pane.

Custom Report Templates
A report template guides you through the choices when creating your own custom
report. The report fields displayed are predefined in the report template according to
the type of report you want. A saved report template containing the options you
selected for your custom report is called a report request. All custom report requests are
based on one of the report templates that are included with Performance Reporting
Manager.

Small differences exist between the report templates, depending upon the type of
request you want to create: a custom performance report or a custom system configuration
report. Performance reports are based on properties that yield numerical results and
that change over time. The data returned can be plotted over time in a graph, for
example. This graph can then be used to determine trends in performance of the
machines. The system configuration reports provide data regarding the details of the
hardware and software configuration of the host.

When you choose a report request from the File menu in Report Manager, a report
template is automatically launched in a dialog box. The template displayed depends
upon the type of report request you choose. The following report templates are
available:

� New Performance Report Request: Use to create reports that provide information
regarding system resource utilization, such as, the amount of disk space or
processor used.

� System Report Request: Use to create reports that provide basic information on
system capacity, such as, the number of disks or processors on a host.

� Hardware Configuration Report Request: Use to create reports that provide
detailed information on the host. For example, the report might detail the specifics
about each processor or each disk on a host.

� Package Report Request: Use to create reports that provide information about the
software packages installed on a host.

� Patch Report Request: Use to create reports that provide information about the
software patches installed on a host.

� Alarms Report Request: Use to create reports that provide information about the
status of alarms on a host.
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The fields possible in a report template are described below. They are grouped
according to those that can be found in both types of reports, those that are found only
in performance reports, and those that are found only in system configuration reports.

Common Custom Report Fields
Many fields in the report template can be found in either a custom performance
template or a custom system configuration template. You build all your custom report
requests by completing the fields in the report template. Your selections define the
nature and scope of the report. Not all fields will be found in every report template.
The template automatically launched after your selection from the File menu in Report
Manager determines what fields are displayed. The fields that can be common to both
performance and system configuration reports are:

� Category
� Subcategory
� Report Request
� Report Title
� Data Properties
� Selected Hosts
� Output Mode
� Customize

Category
Select the desired category from the Category drop-down menu. New categories you
create also appear in the drop-down menu. This field determines where in the
hierarchy view the saved report request appears.

Subcategory
The Subcategory field is optional. Select the desired subcategory from the drop-down
menu. New subcategories you create also appear in the drop-down menu. If used, the
report request appears under the subcategory in the hierarchy view.

Report Request
Provide the name of the report request. This name appears as the title in the report
request. The name also appears both in the report summary and the hierarchy views
in Report Manager.
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Report Title
The Report Title field is optional. This field provides a description of the report that
then appears as the title. This description appears in the report summary of Report
Manager. The report summary is displayed when the name of the report is selected in
the hierarchy view.

Data Properties
Select the data properties to be included in the report in the Data Properties field.
Click Edit to make your selections from the Property Chooser dialog box. There are
some differences between the Property Chooser dialog box that is displayed in the
performance or system configuration report templates. The correct dialog box
automatically launches for you. Only the data properties currently being logged on the
hosts will return data. For more information, see “Data Properties” on page 47.

Selected Hosts
Specify the hosts and corresponding port that you want to include in the report. Only
agent machines that are linked to the server context will return data. If no port is
specified for a host, the default port 161 is assigned. The choices are:

� Enter Hosts at Run Time: You must provide each host and corresponding port
when you run the report request. A separate dialog box for this purpose is
displayed at runtime. The host and corresponding port are not saved to the report
request, and can be changed each time the report is run.

� Select Hosts From Main Console Window (Then Click Update): The hosts and
corresponding ports you provide are saved to the report request. Each time the
report is run, data is returned regarding the hosts originally saved. To select the
desired hosts, go to the Sun Management Center 3.0 Main Console window. Make
your selections either by using Shift+Click, or by drawing a lasso around the icons
that represent the desired hosts. Click Update in the report template to add the
hosts.

� Enter Hosts as Hostname:Port (Comma Delimited): If selected, you enter the host
and the corresponding port. The proper form is to use a comma delimiter without
a space. You can add as many valid hosts and ports as wanted.

Output Mode
Choose the desired format of the report from the Output Mode drop-down menu. The
available options given depend on the type of report request you are creating. The
possible options are:

� Line Graph
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� Bar Chart
� Pie Chart
� Tabular

For more information about the report formats available, see “Report Output Format
Options” on page 16.

Customize
The Customize field is optional. You can further customize the look of a graph report
through the Customize dialog box. This option is available for Line Graph or Bar
Chart report formats only. For more information, see “Customizing the Appearance of
Reports” on page 53.

Performance Report Fields
There are three report fields that are found only in a performance report template.
These report fields are:

� Function
� Time Range
� Graph Orientation

The other fields possible for this type of report are as described in “Common Custom
Report Fields” on page 40.

Function
The Function field controls the type of data that appears in the report. Select the type
of data you want from the drop-down menu . For more information about how data is
collected, see “Data Collection” on page 12. The choices are:

� Raw: If this choice is selected, the raw data logged on the agent machine is
returned. Raw data is logged according to the time interval specified in the
Property Logging Setting dialog box for each data property. The Raw option is
available only for these standard time ranges: Last 4 Hours, Last 24 Hours, Last 3
Days, and Real Time. If the Raw option is chosen for a custom time range, a
maximum of three days of raw data is available.

� Maximum: The maximum value of the most granular level of data available in the
database is returned.

� Average: The average value of the most granular level of data available in the
database is returned.

� Minimum: The minimum value of the most granular level of data available in the
database is returned.
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Time Range
The time the report spans is selected here. The choices for a time range are:

� Standard: Select a predefined time range from the drop-down menu. Choose from
the following time ranges:

� Last 4 Hours: The range starts from the current hour to minus four hours.
� Last 24 Hours: The range starts from the current hour to minus 24 hours.
� Last 3 Days: The range starts from 12:00 a.m. three days before the current date

to 11:59 p.m. the day before the current date.
� Last 7 Days: The range starts from 12:00 a.m. seven days before the current date

to 11:59 p.m. the day before the current date.
� Last Calendar Week: The range starts from 12:00 a.m. Sunday of the previous

week to 11:59 p.m. of the following Saturday.
� Last Calendar Month: The range starts from 12:00 a.m. of the first day of the last

month to 11:59 p.m. of the last day of the last month.
� Real Time: The range starts from the current day and time and goes forward.

This option is only available when the Function selection is Raw.
� Custom: Use this option to define your own time range. First click Edit, then type a

Date and Time Range in the Time Range dialog box. The From and To fields
contain drop-down menus from which you make your selections.

Graph Orientation
If you selected Line Graph or Bar Chart as the output mode, you must choose the
desired orientation of the graphs in the report. The options are:

� One Host, Many Data Properties: A separate graph for each host included in the
report is displayed. Each graph shows all the data properties for that host. Each
data property is shown as a separate line or bar on the graph. Each line or bar is
distinguished by either its color, or its symbol, or both. The legend for the graph
identifies which color or symbol is being used for each data property in the report.
The host name is listed at the top of each graph.

� One Data Property, Many Hosts: A separate graph for each data property included
in the report is displayed. Each graph includes a separate line or bar for every host
in the report. Each line is distinguished by either its color, or its symbols, or both.
The legend for the graph identifies which color or symbol is being used for each
host in the report. The data property is listed at the top of each graph.

� All Hosts and Data Properties on One Graph: Only one graph is displayed. All
hosts and data properties in the report are included. Each line or bar is
distinguished by either its color, or its symbol, or both. The legend for the graph
identifies which color or symbol is being used to identify each host and data
property in the report.
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Custom System Configuration Report Fields
The report template for creating a custom system configuration report has two fields
that are only found in this type of report.

� Level of Detail
� Filter

The other fields possible for this type of report are as described in “Common Custom
Report Fields” on page 40.

Level of Detail
Use the Level of Detail field to determine the amount of detail wanted in the report.
Accept either the default, Detailed, or select Summary. If you select Summary, the
following information is returned:

� Alarm Reports: The number of alarms
� Hardware Reports: The number of hosts
� Packages Reports: The number of packages
� Patch Reports: The number of patches

Filter
The Filter field is optional. Click Set Filter to select the desired filter options from the
Filter dialog box. Use the drop-down menus to build an expression that creates the
report filter wanted. The filtering options are case sensitive. For more information, see
“Filtering Reports” on page 52.

Creating or Modifying a Report Request
You can create your own custom report request by one of the following methods:

� Copying a standard report request, and then modifying the predefined report
options in the copy

� Completing the desired report options in a new report request template

Once a custom report request is saved after using either option, you can later make
changes by using the Modify dialog box. You cannot modify a standard report request
directly, as the report options are predefined and cannot be changed.

� To Create a New Report Request by Modifying a Standard
Report Request

1. Start Report Manager.

For more information, see “To Start Report Manager” on page 33.
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2. Select the name of the standard report request from the hierarchy view.

3. From the Edit menu, choose Copy.

4. Select the category or subcategory name from the hierarchy view under which you
want the new report icon to appear.

5. From the Edit menu, choose Paste.

The copied report icon appears at the bottom of the selected category or subcategory.
The name of the report is “Untitled” followed by a number.

6. From the Edit menu, choose Modify.

A report request dialog box appears with the options of the original standard report
already completed.

7. Type the new name of the report request in the Report Request field.

8. Make the desired changes to the report option. Click OK to save your changes.

The new report name replaces “Untitled” in the hierarchy view.

� To Create a New Report Request
1. Start Report Manager.

For the detailed steps, see “To Start Report Manager” on page 33.

2. From the File menu, choose New, then select the desired report request type.

The report template specific to the type of report that you selected opens.

3. Complete the fields of the report template.

For more information about the report template options, see “Custom Report
Templates” on page 39.

4. (Optional) Click Preview to see a preview of the report.

A preview of the report output is displayed in a new window. The data that has
already been collected is used for a report preview.

5. Click OK to save the report request.

The report request is now saved. The title of the report request appears, with the
corresponding report format icon, in the hierarchy view under the category and
subcategory selected. This report request is available until it is deleted.

� To Modify a Report Request
1. Start Report Manager.

For the detailed steps, see “To Start Report Manager” on page 33.

2. Select the name of the report request you want to modify.
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3. From the Edit menu, choose Modify.

The Modify dialog box opens. The fields contain the current values for Data
Properties, Time Range, Filter, and Selected Hosts.

4. Make your changes to the fields.

5. Click OK to save your changes to the report request.

The following figure is a sample of a New Performance Report Request template.

FIGURE 4–1 Sample New Performance Report Request Template Showing Fields Completed
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Data Properties
The ability to log data is included with the Sun Management Center 3.0 base product.
Performance Reporting Manager uses this logged data in the reports. Only data that is
logged to the circular history.log file on the agent machine is collected for
reporting purposes. Data cannot be included in any report until logging of the data
property is first enabled. Certain data properties are automatically logged for you. If a
property is not being logged, you will not receive any data for that property until
logging is first enabled.

You can use the Data Availability option to determine if a property is already being
logged on the machine. To either enable or disable the logging of a data property, you
can use the history logging capability of Sun Management Center 3.0 or use the group
logging task. For more information about history logging, see Sun Management Center
3.0 User’s Guide. For more information about the group logging task, see “Group
Logging” on page 50

If you receive a No Data Found error message when running a report, first check to
see if the data property is being logged on the agent machine specified in your report.

Data Availability
Only those data properties that are being logged on the agent machine can return data
for reports. The Data Availability dialog box enables you to check what properties are
currently being logged. The information is updated every hour. If you have just
installed Performance Reporting Manager, the data might take an hour to first appear
in the Data Availability dialog box.

Note – The data properties being logged are used for performance reports only.

� To See the Properties Being Logged
1. From the Report Manager file menu, choose Data, and then select Data Availability.

The Data Availability dialog box opens. All agent machines for which data was
collected in the last hour appear in the Hosts Collecting Data drop-down menu.

2. Select the desired host name from the drop-down menu.

The table expands to list all the data properties collected for that host. You can resize
the columns by dragging the cell borders in the column title. You can sort the table by
double-clicking the column headings.

3. Click Close to dismiss the dialog box.
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The following figure shows a sample of the Data Availability dialog box. A note at the
bottom of the dialog box reminds you that data in this table refreshes within an hour.

FIGURE 4–2 Sample of Data Availability Dialog Box with Data Properties Showing

Data Properties Selection
When creating your custom report request, the report template requires that you select
the data properties to include in the report.

The addition of certain properties requires that you provide an entry for either the
module instance or property instance, or both. The module instance is needed only for
multi-instance modules. Examples of a multi-instance module includes File
Monitoring or Directory Monitoring. Each instance can be used for monitoring a
different file or directory. The property instance typically refers to an instance name
given to the property being logged. For example, in a machine with four CPUs, the
CPUs can be numbered 0, 1, 2, and 3. If you are only interested in the performance of
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CPU number 3, you specify 3 as the property instance for the CPU property included
in the report. You specify All as the property instance when you want a report that
includes all instances that exist for the host. For more information, see Sun
Management Center 3.0 User’s Guide.

� To Add Data Properties
1. From the Data Properties field in the New Report Request template, click Edit.

The Property Chooser dialog box appears. It contains two panes. The left pane is titled
Properties to Choose From. The right pane is titled Selected Properties.

2. Expand the hierarchy view in the left pane by clicking the key symbols.

The data properties are located at the third level of the hierarchy.

3. Select the desired property, and click Add.

The property moves to the right pane. If required, the Module Instance or Specific
Property Index fields become active in the lower left-hand corner of the dialog box.

4. (Optional) Provide the Module Instance and Specific Property Index in their
respective text fields.

If module is a multiple instance module, provide the module instance wanted.

5. When you finish adding all desired properties, click OK.

The Property Chooser dialog box closes. Continue completing the report template.

The figure below shows a sample of the Property Chooser dialog box for performance
reports.
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FIGURE 4–3 Sample of the Property Chooser Dialog Box for a Performance Report Request

Group Logging
When you want to log the same data properties on a group of agent machines, you
can use the Group Operation features of the Premier Management Applications
add-on to Sun Management Center 3.0. Instead of adding the same set of data
properties to be logged on each machine individually, you can save time with the
group logging feature. For more information about all the Group Operation features,
see Sun Management Center 3.0 User’s Guide.

� To Add Data Properties to a Group Task
1. From the Sun Management Center 3.0 Main Console File menu, choose Tools, then

select Group Operation.

The Group Operation dialog box appears.
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2. From the File menu, choose New, and then choose Task.

The Create/Edit Tasks dialog box appears.

3. Create a new group task by typing the task name in the text field, and then pressing
Return.

If needed, for more information see Sun Management Center 3.0 User’s Guide.

4. From the Type drop-down list, select Data Logging.

5. Click Add Properties.

The Property Chooser dialog box appears.

6. From the hierarchy view in the left panel, select the data properties one at a time,
and click Add after each one.

The data properties are contained in the third-level in the hierarchy. Each data
property added moves to the right pane.

7. Click OK when done.

The data properties are added to the group task.

8. From the Create/Edit Task dialog box, select the data property.

If you added more than one data property to the group task, you must do this one at a
time.

9. Click Logging Setting.

The Property Logging Setting dialog box launches.

10. If the box next to Logging does not have a check mark, add one.

Logging for the data property is now enabled.

11. Type the desired time interval, in seconds, in the Interval text field.

The default is 300 seconds. The data property is logged at the interval specified.

12. Click OK to save the task and close the dialog box.

� To Run a Group Task
1. From the Sun Management Center 3.0 Main Console File menu, choose Tools, then

select Group Operation.

The Group Operation dialog box appears.

2. Launch the Create/Edit Groups dialog box.

3. From the dialog box, select objects from the domain.

4. From the Sun Management Center 3.0 Main Console, select the names of the
servers, and then click Update.
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You can select the server names either by using Shift+Click, or by drawing a lasso
around each individually, or as a consecutive group.

5. Click OK to save the server names.

6. From the Group Operations window, type the Name, then select the group name
from the drop-down list.

The group name is the one you provided when you created the group task.

7. Select the group task name from the drop-down list.

The group task name is the one you provided when you created the group task.

8. Click the Save/Run icon from the menu.

This is the last icon on the menu. Logging of the data properties chosen earlier starts.

Filtering Reports
You can further modify the type of information that your custom report contains by
using the Filter dialog box. The Filter dialog box is an option contained in some of the
report templates and is used when creating a custom system configuration report
request.

The Filter dialog box contains several drop-down menus and text fields that are used
to build an expression. This expression defines the report parameters to include the
filter criteria wanted. The expression operators provided are common to the C
programming language. Filter options are case sensitive.

For example, you can create a custom system configuration report request for a report
that contains data only on machines that are running the Solaris 7 or Solaris 8
operating environments. To do this, you would create the following expression using
the Filter dialog box:

Operating System = SunOS 5.7
OR
Operating System = SunOS 5.8

As another example, you can create a custom system configuration report request for a
report that includes only the machines that have the SyMON packages installed. To do
this, you would create the following expression:

Category contains SyMON

In order to include only those machines that have the Sun Management Center 3.0
SyMon packages installed, you can modify the above example this way:

Category contains SyMON AND Version contains 3.0
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Customizing the Appearance of Reports
Some custom report templates have an option that enables you to customize the
appearance of your Line Graph, Bar Chart, and Pie Chart reports. You can either add
these customizing features when you are initially creating the report request, or you
can later modify the report request to include the desired appearance customization.

After you click the Customize button in the report template, the Customize Graph
dialog box appears. The dialog box contains the following three tabs, from which you
can specify these appearance changes:

� Titles & Legend: You can add a Footer and change the Legend Text. From the
drop-down menus, you can choose the placement of the Footer or Legend on the
graph. You can change the X-Axis and Y-Axis Labels using the text fields.

� Line Attributes: Use the All Lines options to change the appearance of the Line
Thickness or Line Style, and Symbol Size. Use the drop-down menus to make your
selections. Use the Specific Line options to change the appearance of a line you
select from the drop-down menu.

� Size & Spacing: Use the text fields to control the size of the graph width and
height, or the X-Axis and Y-Axis scale. You enable grid lines on the graph by
selecting Show Grid. The value range for grid spacing is 0 to 100.

Note – Some of the options in the Customize Graph dialog box are not available for
Pie Chart reports.

Once you have finished selecting all the customizing options, click OK to dismiss the
dialog box. You must also click OK from the report template for these options to be
saved to the report request.

Composite Report Requests
Performance Reporting Manager enables you to combine two or more existing report
requests to create a new report request. The resulting report request is called a
composite report request. To create a composite report request, you can use existing
standard or custom report requests, or a combination of both types. A composite
report request combines the options of the report requests used. You specify a new
name for the composite report request, and then the report is identified in the
hierarchy view under the category and subcategory selected.
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If the host name is not defined in any report request, you cannot select that request to
become part of a composite report request. For example, you cannot select any report
request for which the option Add Hosts at Runtime was specified.

You cannot delete or rename any existing standard or custom report request once it is
referenced by a composite report request, unless you first delete the composite report
request.

� To Create a Composite Report Request
1. From the Report Manager File menu, choose New, then select Composite Request

Request.

The Composite Report Request dialog box opens.

2. Select the desired category and subcategory from the drop-down menus, and type a
name for the report in the Name field.

3. Select the desired reports from the left pane. Use the Add button to move the
reports to the right pane that is titled Selected Report Requests.

Use the Remove button if you select a report you do not want. The Remove All button
will clear all selections from the right pane.

4. (Optional) Click Preview to see a preview of the report.

A preview of the report output is displayed in a new window. The data that has
already been collected is used for a preview of a report request.

5. Click OK to save the report request.

The composite report request is now saved. The title of the composite report request
appears in the hierarchy view under the category and subcategory selected. This
report is available until it is deleted.
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CHAPTER 5

Report Options

This chapter discusses the following topics:

� “Report Options Overview” on page 55
� “Scheduling Reports” on page 56
� “Options for Viewing Report Output” on page 57
� “Accessing Reports From the Sun Management Center Web Server” on page 58
� “Line Graph Report Viewing Options” on page 60
� “Stopping Data Collection” on page 61

Report Options Overview
Performance Reporting Manager includes several options that enable you to tailor the
reporting capabilities to meet your specific needs. For example:

� You can schedule reports to automatically generate as needed.

� If you decide that you no longer need to monitor a particular host for a report, you
can stop collecting data on that host.

� The report output can be saved in HTML for viewing in a web browser.

� Reports can be saved in comma-separated values (CSV) ASCII text form, in
addition to using other delimeters of choice.

For more information about viewing reports in a web browser, see “Options for
Viewing Report Output” on page 57.
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Scheduling Reports
You can schedule any standard or custom report request to automatically generate at a
regular interval, as long as the host names are saved in the report request. The output
from all scheduled reports is posted to the Sun Management Center 3.0 server
machine. The reports are saved in a directory on the server machine. You access these
reports by typing in a browser: http://server-machine-name/reports.

The scheduling of reports and the server side generation of reports requires the use of
an X server. You must first ensure that your environment is set correctly before
scheduling reports.

� To Schedule a Report
1. Verify that an X server session is running on the Sun Management Center 3.0 server

machine.

For the detailed steps, see “To Set the Environment” on page 26.

2. From the Report Manager File menu, choose Schedule, and then select Schedule
Report Generation.

The Schedule Report Generation dialog box opens.

3. Select the name of the desired report request from the hierarchy view contained in
the left pane.

The report requests are located at the third level in the hierarchy view.

4. Click the Add button.

The name of the report request moves to the right pane.

5. (Optional) Select Multiple Report Requests if have more than one report to
schedule for the same time.

Select this option only if you want all the reports to run at the same time.

6. Complete the Date, Time and Repeat Interval fields.

The date format is specific to the locale. Provide the date as specified in the date label.
Make your selections for the Time and Repeat Interval fields from the drop-down
menu.

7. Click OK to schedule the report.

The report is now scheduled to generate according to your selections. The report will
continue to generate at the interval specified, until the request is deleted.
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� To Remove a Scheduled Report
1. From the Report Manager File menu, choose Schedule, and then select View

Scheduled Report Status.

A new window opens with a table containing a status of all currently scheduled
reports. You can resize the table columns by dragging the cell border of the header
title.

2. Select the row that contains the name of the report to be removed.

3. Click Remove.

The report is removed from the table.

4. Click OK.

The report is no longer scheduled to be generated

Options for Viewing Report Output
After a report is generated, you have several options for viewing and saving the
output. These options include the following outputs:

� View a report as an HTML file in a browser
� Post any saved reports as HTML files to a Sun Management Center server for

others to view
� Save the report in a tab-separated or comma-separated value (CSV) ASCII text file

that can be used with other tools to analyze the data

Reports saved as an HTML file can be viewed using Netscape Navigator™ 4.5.1, or
higher, or Internet Explorer 5.0, or higher.

� To View a Report as HTML in a Browser
1. Generate the desired report.

The report output is shown in a separate window. For the detailed steps, see “To
Generate a Standard Report” on page 35.

2. Choose Show in Web Browser from the File menu in the report window.

The web browser launches and the report is displayed as HTML.
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� To Post to a Sun Management Center Web Server
1. Generate the desired report request.

The report output is shown in a separate window. For the detailed steps, see “To
Generate a Standard Report” on page 35.

2. Choose Post to a Web Server from the File menu in the report window.

The report is posted to the Sun Management Center 3.0 server you to which are
connected , which acts as a web server.

� To Export Data
1. Generate the desired report.

The report output is shown in a separate window. For the detailed steps, see “To
Generate a Standard Report” on page 35.

2. Choose Export Data from the File menu in the report window.

The Export Data dialog box appears.

3. Select either Comma or Tab as the delimiter.

4. Choose the directory in which to save the file.

5. Type a name in the File Name text field.

6. Select the File Type from the drop-down menu.

7. Click Save.

Accessing Reports From the Sun
Management Center Web Server
Once a report has been saved and posted to a Sun Management Center 3.0 web server,
you can view the report as HTML in a browser. All scheduled reports are posted to the
Sun Management Center 3.0 server machine. You can also post an individual report by
using the Post to a Web Server option from the report’s menu. A list of all reports ever
posted appears in the browser window that is opened from the server. All reports will
continue to appear until the report is deleted.
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� To Access a Posted Report
1. Launch the Sun Management Center 3.0 web server by typing in a browser:

http://server-machine-name/reports

2. Login by typing the Login and Password in the text fields.

Use the same Login name and Password that are required for the Sun Management
Center 3.0 server.

A table is displayed in the browser window that lists all the reports that have been
posted to the web server. The name of the Report Request, the report Category and
Subcategory, the Report Title, and the Create Time are displayed in the table.

3. To view a report, click on the name contained in the Report Title field.

The report is displayed in the browser window.

4. (Optional) To print the report, use the Print option from the browser’s menu.

5. Close the browser from the browser’s menu.

� To Delete a Posted Report
1. Log in to the Sun Management Center 3.0 web server.

For the detailed steps, see steps 1 and 2 in “To Access a Posted Report” on page 59.

2. Located the name of the report in the table, then click the corresponding Delete
button.

A second dialog box appears that asks you to confirm the deletion request.

3. Click OK to confirm the deletion request.

The report is deleted from the list in the table, and is removed from the web server.

The figure below shows a sample of the list of posted reports as it appears in a
browser window.
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FIGURE 5–1 Sample of a Browser Window With a List of Reports That Are Posted to a Web Server

Line Graph Report Viewing Options
If your report is in Line Graph format, you have several options for viewing the data.
At the top of the report window are several buttons used for accessing the options.
First, click the desired point on a graph, then click one of the following buttons:

� Disabled: Deactivates the mouse so a click on any line in the graph will not register.
� Zoom: Enlarges, or zooms, the area selected on any line. Either click the desired

point, or draw a lasso around a series of points for which you want more detail.
The area selected will appear in enlarged detail.

� Alarms: A second window appears that contains a tabular report providing alarm
details for the date range specified in the report request.

� Processes: A second window appears that contains two tabular reports providing
detail about processes. One report is titled the Top 10 CPU Processes, and the other
is titled Top 10 Memory Processes. The report information is for the time
represented by the data point nearest to the point selected on the line. Process data
is logged every 15 minutes and is only available for the last 8 days.

� Reset Zoom: Resets the graph orientation back to the initial starting point.
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Customizing Line Graph Reports
Once you have run a report in line graph format, you can further customize the
appearance of the report. From the Edit menu, choose Customize Graph. The options
are the same as when completing a new custom report template. The difference is that
the customizing options you select after running a report apply only to that report.
You cannot save the changes, but you can post the customized report to a Sun
Management Center web server for viewing or printing.

For more detail about the Customize Graph options, see “Customizing the
Appearance of Reports” on page 53.

Stopping Data Collection
You can stop data collection on any agent machine that you no longer need to include
in reports.

� To Stop Data Collection
1. From the Report Manager File menu, choose Data, and then select Data Collection.

The Data Collection dialog box opens. All hosts for which data is not currently being
collected are listed in the left pane. All hosts for which data is currently being collected
are listed in the right pane.

2. Select the name of the host.

3. Use the Add, Add All, Remove, and Remove All buttons to move the host names as
needed.

You must change the status of collection on the hosts one at a time.

4. Click OK to save the changes.
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APPENDIX A

Reference

This appendix contains reference information for the Performance Reporting Manager
add-on software.

Prerequisite Packages
The following Solaris operating environment packages are required on the Sun
Management Center 3.0 server layer. If you have already installed and set up the Sun
Management Center 3.0 server layer, the presence of these Solaris packages will be
checked by the Sun Management Center 3.0 installation script.

� SUNWsprot: Solaris Bundled tools
� SUNWtoo: Programming Tools
� SUNWbtool: CCS tools bundled with SunOS

Default Logging Properties
The following lists contain the properties that are logged by default on the Sun
Management Center 3.0 agent machines that have the Performance Reporting
Manager software installed. You will have either the kernelReader (simple)
module or the kernelReader module on your system.

The kernelReader (simple) module default properties are:

Load Average Over Last 5 Minutes
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Physical Memory Free (MB)
Available KB (Anon Memory Not Reserved)
CPU User Time %
CPU Idle Time %
CPU Kernel Time %
CPU Wait Time On I/O %

The kernelReader module default properties are:

Load Average Over Last 5 Minutes
Physical Memory Free (MB)
Available KB (Anon Memory Not Reserved)
CPU User Time %
CPU Idle Time %
CPU Kernel Time %
CPU Wait Time On I/O %

Predefined Options for Standard Reports
Each standard report included in Performance Reporting Manager contains predefined
report options that you cannot edit. The following table lists these predefined options.

TABLE A–1 Standard Report Options

Report
Request Name Category Subcategory Data Properties Host and Port

Report
Format

CPU
Utilization

Performance CPU % CPU Kernel Time
#ALL, % CPU User
Time #ALL

Enter at
runtime

Line
Graph

Swap
Available

Performance Swap Available KB (Anon
Memory Not
Reserved)

Enter at
runtime

Line
Graph

Memory
Free

Performance Memory Physical Memory
Free (MB)

Enter at
runtime

Line
Graph

Alarm
Details

Alarm Alarms Hostname, OS,
Alarm Severity,
Alarm Status, Open
Date, Alarm
Message

Enter at
runtime

Table
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TABLE A–1 Standard Report Options (Continued)
Report
Request Name Category Subcategory Data Properties Host and Port

Report
Format

Alarm
Summary

Alarm Alarms Hostname, Alarm
Status

All hosts in
the server
context

Table

Alarm
Severity
Count By
Host

Alarm Alarms Hostname, Alarm
Severity, Alarm
Status

All hosts in
the server
context

Table

System
Details

Hardware System Hostname,
Operating System,
System Clock
Frequency, Platform
Type, Total Disks,
Total Memory, Total
Processors, Total
Tape Devices

All hosts in
the server
context that
have the
Config-
Reader
add-on
installed

Table

Platform
Summary

Hardware System Platform All hosts in
the server
context that
have the
Config-
Reader
add-on
installed

Table

OS Summary Hardware System Operating System All hosts in
the server
context that
have the
Config-
Reader
add-on
installed

Table

Hosts with
SUNWcsr
Package

Software Packages Hostname, Package
Instance, Package
Name, Category,
Version, Package
Description, Install
Date

All hosts in
the server
context

Table

Package
Details

Software Packages Hostname, Package
Instance, Package
Name, Category,
Version, Package
Description, Install
Date

Enter at
runtime

Table
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TABLE A–1 Standard Report Options (Continued)
Report
Request Name Category Subcategory Data Properties Host and Port

Report
Format

Patch Details Software Patches Hostname,
Operating System,
PatchID, Packages,
Obsoletes, Requires,
Incompatibles

Enter at
runtime

Table

For more information about standard reports, see “Standard Reports Overview”
on page 29.
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Glossary

custom report A report you create by choosing the report specifications from the
options given in the report template. The choices are saved to a report
request, which is used to generate the report when needed.

data collection service This service exists on the server layer. It collects data from the agent
machines and stores the data in the database on the server.

generate To run a report request, creating a viewable report.

group logging The ability to log the same set of data properties on a group of agent
machines. Group logging is part of the Group Operation features of
the Premier Management Applications add-on that Performance
Reporting Manager uses.

history logging The ability to log data that is part of Sun Management Center 3.0.
Logged data is collected and stored in the circular history.log file
that is located on the agent machine. This data is used in reports
created with Performance Reporting Manager.

hourly data Data that has been summarized, or rolled-up, every hour.

lock icon The lock symbol that is added to all standard report icons to remind
you that the report specifications are predefined and cannot be
changed.

logging component This component exists on agent machines. It is added as part of the
Performance Reporting Manager installation to perform logging of
system data properties.

module instance An entry in the Property Chooser dialog box when adding data
properties to a custom performance report request. The module
instance is required only for multi-instance modules, for example, File
Monitoring or Directory Monitoring.

performance report A report that is designed to track properties that are numerical and
that change over time.

67



property instance An instance name given to the data property that is being logged. A
property instance can be a required entry in the Property Chooser
dialog box when adding data properties to a custom performance
report request.

raw data Data that is logged in the history log (history.log) files located on
the agent machines. Raw data is retained on the agent machine for
eight days. The data is summarized, or rolled-up, before it is purged.

Report Manager The graphical user interface in Performance Reporting Manager from
which you manage all report activity. Report Manager is linked to the
Sun Management Center 3.0 Java console only.

report request Contains the saved report specifications that define the scope and
nature of the report. A report request is used to generate any report.

report template A form included with Performance Reporting Manager that guides
you through the choices when creating your own custom report
request. Several report templates are provided, each specific to the
type of report request being created. The correct template is
automatically displayed, depending upon the report type selected
from the File menu.

roll-up data Data that has been summarized. All data is summarized, or rolled-up,
before it is purged.

standard report A report whose report request is included with the product and has
the report specifications predefined. The report specifications in a
standard report request cannot be changed.

system configuration
report

A report designed to provide data that details the state of the
configuration on a machine.
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Index

A
Alarm Details report, 31
alarm reports

description of, 31
host name, 12

Alarm Severity Count By Host report, 31
Alarm Summary report, 31
Alarms button, 17, 60
average data, 42

B
backing up data, 27
bar chart reports

customizing, 53
description of, 18

browser, viewing reports in, 57

C
category

adding new, 38
predefined, 15
selecting, 40

column sizing, 16
composite report request, 53
CPU Utilization report, 30
custom reports, 37

determining data type for, 42
templates for, 39
time range for, 43

Customize, report field, 42
customizing

report appearance, 53, 61

D
data

availability, 14
exporting, 58
hardware configuration, 14
hardware system, 14
hourly report of, 13
patch and package, 14
performance, 30
rolled-up, 13
stopping collection of, 61
summary, 14
transfer of, 30
types of collection, 12

Data Availability dialog box, 47
data collection, 14

stopping, 61
types of, 12

data collection service, 12, 14
data files, server layer, 25
data logging, 13, 47

intervals, 14
performance, 30

data properties
adding, 48
adding for group task, 50
available, 47
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data properties (Continued)
report field, 41, 48

data types, 12
database, 31
date format, 56
Disabled button, 60
disk space requirements, 21

E
environment, setting, 26
exporting data, 58

F
Filter dialog box, 52
filtering reports, 52
Function field, 42

G
Generate icon, 34
generating a report, 34
graph orientation, 43
group logging, 50
grouping functionality, logging interval, 13

H
hierarchy view, 32
history.log file, 47
host name

alarm reports, 12
standard performance report, 34

Hosts with SUNWcsr package report, 32
hourly data, 13
HTML, viewing a report as, 57

I
installation

layers, 23
requirements, 22

K
Kernel Reader Simple module, 30

L
level of detail, report field, 44
Line Attributes tab, 53
line graph reports, 17

customizing, 53
viewing options, 17, 60

lock symbol, 16, 29
logging component, 31
logging properties, default, 63

M
maximum data, 42
Memory Free report, 30
minimum data, 42
modifying a report request, 44
module instance, 48
multi-instance modules, 48

N
No Data Found error, 47

O
OS Summary report, 31
output mode, 41

P
Package Details reports, 32
packages

add-on, 23
prerequisite Solaris, 63

Patch Details reports, 32
patches

minimum level, 22
obtaining, 22
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Performance Reporting Manager
installing, 23
patch level for, 22
prerequisites for, 21
removing, 28
setting up, 25
software packages, 23

performance reports, 29, 39
report fields, 42

pie chart reports, 53
customizing, 53
description of, 19

Platform Summary report, 31
port, default, 41
posted reports, 58
preview, 45, 54
Processes button, 17, 60
property chooser dialog box, 41
property instance, 48

R
raw data, 13, 42
raw function, 42
real time, 43

graph refresh interval, 17
Refesh button, 16
report, standard icon, 16
report data

availability, 14, 47
report field

Category, 40
common to all templates, 40
Customize, 42
Data Properties, 41
Filter, 44
Function, 42
Graph Orientation, 43
Level of Detail, 44
Output Mode, 41
performance report template only, 42
Report Request, 40
Report Title, 41
Selected Hosts, 41
Subcategory, 40
system configuration report template only,

44

report field (Continued)
Time Range, 43

report formats
bar chart, 18
line graph, 17
pie chart, 19
table, 16

Report Manager GUI, 32
Report Request report field, 40
report requests

alarms, 39
composite, 53
definition of, 39
description of, 15
hardware configuration, 39
hierarchy view, 32
modifying, 44
package, 39
patch, 39
performance, 39
system, 39

reports
custom, 37
formats, 16
generating, 34
icons, 16
performance, 29, 39
posted as HTML, 58
scheduling, 56
standard, 29
standard system configuration, 29
system configuration, 39
templates, 37, 39
types, 11
viewing in different formats, 57

Reset Zoom button, 60
roll-up data, 13

S
samples

Data Availability dialog box, 48
line graph report, 17
New Performance Report Request template,

46
posted reports in a browser, 59
Property Chooser dialog box, 49
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samples (Continued)
Report Manager, 33

scheduling a report, 56
script

es-inst, 23
setup, 25

selected hosts, choices, 41
server layer, data files, 25
setup

script, 25
server data files, 25

Size & Spacing tab, 53
software version, command, 22
sorting tabular reports, 16
standard performance reports

CPU Utilization, 30
host name, 34
Memory Free, 30
Swap Available, 30
types, 30

standard reports, 29
Alarm Details, 31
Alarm Severity Count By Host, 31
Alarm Summary, 31
Hosts with SUNWcsr package, 32
Kernel Reader Simple module, 30
OS Summary, 31
Package Details, 32
Patch Details, 32
performance, 29
Platform Summary, 31
system configuration, 29
System Details, 31

standard system configuration reports, host
name, 35

subcategory
adding new, 38
predefined, 15
selecting, 40

Swap Available report, 30
system configuration reports, 39

level of detail in, 44
types, 31

System Details report, 31

T
tabular reports, 16
template fields, 40
Titles & Legend tab, 53
Top 10 CPU Processes report, 60
Top 10 Memory Processes report, 60

V
viewing report output, 57

X
x server, 26, 56

Z
Zoom button, 17, 60

72 Sun Management Center 3.0 Performance Reporting Manager User’s Guide • May 2002


